
1D Stackup_Block Model

3차원 공차분석 예제 모델 / CETOL

Balance between Design Performance & Cost

측정지점
Min/Max값은?

Measurements
CTP/CTQ

1
2

3
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이번 과정에서는. . .

• 따라하기 예제를 통해

1. 1D Stack-up tolerance(1차원 누적공차)의 이해하고, 

2. CETOL 6σ의 기본적인 기능을 알아봅니다.

• 처음사용하시는 분들을 위해

• 이번 예제 모델은 

Step by step으로 구성하였습니다.

측정지점
Min/Max값은?

1
2

3

CETOL 6 Modeler

Assembly Modeling

• 기구학적 조립 관계 설정

• 조립 상세 설정

Define Objectives

• 분석 위치(검토지점) 설정

• 분석 위치 상세 설정

Part Modeling

• Feature관계 설정(Size, Dimension, GD&T, etc.)

• 공차 상세 설정

Validate Model

• (정보, 경고, 에러) Advisor message 확인

• 조립 관계도 확인 “Show Part Locations”

• 시각화 기능 활용 검토(Sensitivities, Response)

12

3

4

Tolerance Analysis Procedure

3

https://www.tsne.co.kr/
https://www.tsne.co.kr/pc/public/sub2/7-0-0.php


Stack-up Tolerance 이해

• 1D 누적공차 수 계산 연습 1
2

3
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Stack-up Tolerance

• 아래 그림의 Worst Case의 Min/Max 값을 구하시오.

수 계산으로 

Blocks의 Min/Max값

을 계산해 

보세요. 

다음 슬라이드에 정답이 
있습니다.

1

2

3
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Stack-up Tolerance

• 아래 그림의 Worst Case의 Min/Max 값을 구하시오.

Block 1 Block 2 Block 3

30±0.3 20±0.2
25+0.1

-0.2

Max 30.3 20.2 25.1

Min 29.7 19.8 24.8

Blocks total

75.6

74.3

(30.3+20.2+25.1)

(29.7+19.8+24.8)

1

2

3

Spreadsheet 활용
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Stack-up Tolerance

• 아래 그림의 Worst Case의 Min/Max 값을 구하시오.

Blocks total

75.6

74.3

(30.3+20.2+25.1)

(29.7+19.8+24.8)

1

2

3

Worst Case 
Results

WC결과에 대한
기여도 리스트

수 계산 결과와 
CETOL 6σ에서 산출된
결과와 동일함을 확인

https://www.tsne.co.kr/
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Stack-up Tolerance

• 아래 그림에서 측정지점의 Min/Max 값을 구하시오.

측정지점
Min/Max값은? 1

2
3

Dimensions Chain
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Stack-up Tolerance

• Stack-up tolerance 일반적인 이해와 활용

측정지점
Min/Max값은?

Measurements
CTP/CTQ

Block 1 Block 2 Block 3 Block total

Max 30.3 20.2 25.1 75.6

Min 29.7 19.8 24.8 74.3

BASE

Max 80.2

Min 79.8

Max / Min

5.9

4.2

CTQ(Critical to Quality) : 관리항목

CTP(Critical to Process) : 점검항목

Spreadsheet 활용
1

2
3

Dimensions Chain
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Stack-up Tolerance

• Stack-up tolerance 일반적인 이해와 활용

측정지점
Min/Max값은?

Measurements
CTP/CTQ

Block 1 Block 2 Block 3 Block total

Max 30.3 20.2 25.1 75.6

Min 29.7 19.8 24.8 74.3

BASE

Max 80.2

Min 79.8

Max / Min

5.9

4.2

1
2

3

품질 요구사항이 Max: 5.5 / Min 4.0 이라면?

Dimensions Chain

CTQ(Critical to Quality) : 관리항목

CTP(Critical to Process) : 점검항목

Spreadsheet 활용

요구사항을 만족시키기 위해서 
어떻게 해야 할까요? (고민해봐야 할 사항)

• 경험 활용? 
• 치수 & 공차 임의 보정?
• 기여도 확인? ETC.

https://www.tsne.co.kr/
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Stack-up Tolerance

• 아래 그림의 측정지점의 Min/Max 값을 구하시오.

측정지점
Min/Max값은?

1
2

3

Block 1 Block 2 Block 3 Block total

Max 30.3 20.2 25.1 75.6

Min 29.7 19.8 24.8 74.3

BASE

Max 80.2

Min 79.8

Max / Min

5.9

4.2

품질 요구사항이 Max: 5.5 / Min 4.0 이라면?

WC결과에 대한
기여도 리스트

Worst Case 
Results

CETOL 6σ에서는 
산출된 기여도를 활용하여
품질 요구사항에 맞는 적절한 공차값을 적용하고 
검토 할 수 있습니다.

https://www.tsne.co.kr/
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공차분석(Tolerance Analysis)이란?

• 치수 공차(DT) 및 기하 공차(GD&T)를 가지는 단품, 

조립품이 생산-조립되면서 발생하는 누적공차가, 

품질 기준으로 요구되는 허용공차 범위에 부합한지 분석하는 과정

• 요구되는 품질 기준에 부합하지 않다면, 

영향도 높은 공차들을 제어하여 

목표 품질을 달성하는 일련의 모든 분석 과정

Is your tolerance design OK? / Not OK?

조립성에 영향이 큰 공차는?

공차 or 치수를 어떻게 조정?

(각 제품의 사이즈 및 공차 변화에 따라 조립편차 발생)  

Gap Overlap

https://www.tsne.co.kr/
https://www.tsne.co.kr/pc/public/sub2/7-0-0.php


Stack-up Tolerance 따라하기(실습)

• CETOL 6σ에서 따라하기

• 측정지점(Measurements)

• 조립관계(Joint Modeling)

• 치수관계(Part Modeling)

1
2

3
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Stack-up Tolerance 따라하기(실습)

• 모델 불러오기

1. CETOL 6σ 실행
2. File → New
3. 예제폴더에서 “1D stackup_block” 열기
4. Model Units 팝업창 발생한다면

“Millimeter” 선택 후 OK

https://www.tsne.co.kr/
https://www.tsne.co.kr/pc/public/sub2/7-0-0.php


!! 여기서 잠깐 !!

• 마우스 컨트롤 확인하기(연습)

필요에 따라 Options → “Display & 
Highlighting”탭 에서 Mouse Gestures 선택

CETOL 기본교육 교재 또는
ebook교재의 “CETOL Interface”의 목차를 참조 하시면
좀 더 자세한 내용을 살펴 보실 수 있습니다.

※ CETOL Help 위치
→ CETOL 6σ Overview → The CETOL 6σ Modeler Interface →
Application Options → Display & Highlighting

15
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!! 여기서 잠깐 !!

• UI 조정 합니다 (사용자 성향에 따라. . .)

각 창의 환경을 조정 합니다. (위치, 크기, ETC)
✓ Graph, Properties, Advisor, Tree
✓ 만약 창이 보이지 않는다면 View에서 해당창을 선택 합니다.

1
2

3
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Tolerance Analysis Procedure

CETOL 6 Modeler
Assembly Modeling

• 기구학적 조립 관계 설정

• 조립 상세 설정

Define Objectives

• 분석 위치(검토지점) 설정

• 분석 취치 상세 설정

Part Modeling

• Feature관계 설정(Size, Dimension, GD&T, etc.)

• 공차 상세 설정

Validate Model

• (정보, 경고, 에러) Advisor message 확인

• 조립 관계도 확인 “Show Part Locations”

• 시각화 기능 활용 검토(Sensitivities, Response)

12

3

4

첫번째로 

검토지점(Measurement)을 
설정 합니다. 

(숙련도가 일정 이상 올라가면
1번, 2번의 작업은 유연하게 
대처 할 수 있습니다.)

https://www.tsne.co.kr/
https://www.tsne.co.kr/pc/public/sub2/7-0-0.php


Stack-up Tolerance 따라하기(실습)

• 측정지점(Measurements) 설정하기

1. “Measure”를 클릭 합니다.

2. 첫번째 팝업(Feature Collector)창에서

feature를 선택 후 OK 버튼 클릭합니다.

3. 두번째 팝업(Feature Collector)창에서

feature를 선택 후 OK 버튼 클릭합니다.

Feature 선택 후 
OK 클릭

Feature 선택 후 
OK 클릭

2 3

1

18
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Stack-up Tolerance 따라하기(실습)

• 측정지점(Measurements) 설정하기

Measure 설정 완료된 모습

Add Measurement 팝업창에서 OK버튼을 클릭 합니다.
→ Cancel 누를 시에 Measure설정은 취소 됩니다.

선택(클릭)

Measure를 선택하면
상세정보를 볼 수 있습니다. 

19

https://www.tsne.co.kr/
https://www.tsne.co.kr/pc/public/sub2/7-0-0.php


20

Tolerance Analysis Procedure

CETOL 6 Modeler
Assembly Modeling

• 기구학적 조립 관계 설정

• 조립 상세 설정

Define Objectives

• 분석 위치(검토지점) 설정

• 분석 취치 상세 설정

Part Modeling

• Feature관계 설정(Size, Dimension, GD&T, etc.)

• 공차 상세 설정

Validate Model

• (정보, 경고, 에러) Advisor message 확인

• 조립 관계도 확인 “Show Part Locations”

• 시각화 기능 활용 검토(Sensitivities, Response)

12

3

4

두번째로 

부품간 조립관계(Joint)를
설정 합니다. 

→ 조립순서(우선순위) 고려
→ 자유도 구속

https://www.tsne.co.kr/
https://www.tsne.co.kr/pc/public/sub2/7-0-0.php


Stack-up Tolerance 따라하기(실습)

• 부품간 조립관계(Joint) 설정하기.

1

1. “Joint”를 클릭 합니다.

2. 첫번째 팝업(Feature Collector)창에서
Base Part의 상단 feature 선택 후 OK 
버튼 클릭합니다.

3. 두번째 팝업(Feature Collector)창에서
1번 block의 하부 feature를 선택 후 OK 
버튼 클릭합니다.

1
2

3

2 3

1
화면에서 
파트위에 마우스 우 클릭 시
커서위치의 feature가 순차적으로 
가 선택 되어짐

→ 가 선택 후 마우스 좌 버튼 클릭

Block1 Joint

21
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Stack-up Tolerance 따라하기(실습)

• 부품간 조립관계(Joint) 설정하기.

Joint를 선택하면
상세정보를 볼 수 있습니다. 

Add Joint 팝업창에서 OK버튼을 클릭 합니다.
→ Cancel 누를 시에 Joint설정은 취소 됩니다.

Measure 설정 완료된 모습

Block1 Joint

22
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Stack-up Tolerance 따라하기(실습)

• 부품간 조립관계(Joint) 설정하기.

1

2 3

1

1

1. “Joint”를 클릭 합니다.

2. 첫번째 팝업(Feature Collector)창에서
Base Part의 상단 왼쪽 feature 선택 후 
OK 버튼 클릭합니다.

3. 두번째 팝업(Feature Collector)창에서
1번 block의 왼쪽 feature를 선택 후 OK 
버튼 클릭합니다.

화면에서 
파트위에 마우스 우 클릭 시
커서위치의 feature가 순차적으로 
가 선택 되어짐

→ 가 선택 후 마우스 좌 버튼 클릭

Block1 Joint

https://www.tsne.co.kr/
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Stack-up Tolerance 따라하기(실습)

• 부품간 조립관계(Joint) 설정하기.

Block1 Joint

1

Add Joint 팝업창에서 OK버튼을 클릭 합니다.
→ Cancel 누를 시에 Joint설정은 취소 됩니다.

24
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Stack-up Tolerance 따라하기(실습)

• 부품간 조립관계(Joint) 설정하기.

Block2 Joint

1

3

2

화면에서 
파트위에 마우스 우 클릭 시
커서위치의 feature가 순차적으로 
가 선택 되어짐

→ 가 선택 후 마우스 좌 버튼 클릭 2

1. “Joint”를 클릭 합니다.

2. 첫번째 팝업(Feature Collector)창에서
Base Part의 상단 feature 선택 후 OK 
버튼 클릭합니다.

3. 두번째 팝업(Feature Collector)창에서
2번 block의 하부 feature를 선택 후 OK 
버튼 클릭합니다.

4. Add Joint 팝업창은 OK버튼을 클릭합니다. 

25
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Stack-up Tolerance 따라하기(실습)

• 부품간 조립관계(Joint) 설정하기.

1

Block2 Joint

1. “Joint”를 클릭 합니다.

2. 첫번째 팝업(Feature Collector)창에서
2번 block의 좌측 feature 선택 후 OK 
버튼 클릭합니다.

3. 두번째 팝업(Feature Collector)창에서
1번 block의 우측 feature를 선택 후 OK 
버튼 클릭합니다.

2

2

3

1

화면에서 
파트위에 마우스 우 클릭 시
커서위치의 feature가 순차적으로 
가 선택 되어짐

→ 가 선택 후 마우스 좌 버튼 클릭

4. Add Joint 팝업창은 OK버튼을 클릭합니다. 

26
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Stack-up Tolerance 따라하기(실습)

• 부품간 조립관계(Joint) 설정하기.

Block3 Joint

1

1. “Joint”를 클릭 합니다.

2. 첫번째 팝업(Feature Collector)창에서
Base Part의 상단 feature 선택 후 OK 
버튼 클릭합니다.

3. 두번째 팝업(Feature Collector)창에서
3번 block의 하단 feature를 선택 후 OK 
버튼 클릭합니다.

4. Add Joint 팝업창은 OK버튼을 클릭합니다. 

2 3

3

3

화면에서 
파트위에 마우스 우 클릭 시
커서위치의 feature가 순차적으로 
가 선택 되어짐

→ 가 선택 후 마우스 좌 버튼 클릭

27
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Stack-up Tolerance 따라하기(실습)

• 부품간 조립관계(Joint) 설정하기.

1

Block3 Joint

1. “Joint”를 클릭 합니다.

2. 첫번째 팝업(Feature Collector)창에서
2번 Block의 우측 feature 선택 후 OK 
버튼 클릭합니다.

3. 두번째 팝업(Feature Collector)창에서
3번 block의 좌측 feature를 선택 후 OK 
버튼 클릭합니다.

4. Add Joint 팝업창은 OK버튼을 클릭합니다. 

2 3

3
2

화면에서 
파트위에 마우스 우 클릭 시
커서위치의 feature가 순차적으로 
가 선택 되어짐

→ 가 선택 후 마우스 좌 버튼 클릭

28
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Stack-up Tolerance 따라하기(실습)

• CETOL Tree 정리

→ Joint 작업전에 Tree의 Part
순서를 (선)정의해야 하나, 
이번 예제모델 에서는 무시 합
니다. (후 정의)

→ Tree에서 drag & drop으로 
Part 이동

drag & 
drop

정리 완료된 Tree

→ 기준 파트는 Base

→ 조립 순서는 1번 part부터

1
2

3
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Tolerance Analysis Procedure

CETOL 6 Modeler
Assembly Modeling

• 기구학적 조립 관계 설정

• 조립 상세 설정

Define Objectives

• 분석 위치(검토지점) 설정

• 분석 취치 상세 설정

Part Modeling

• Feature관계 설정(Size, Dimension, GD&T, etc.)

• 공차 상세 설정

Validate Model

• (정보, 경고, 에러) Advisor message 확인

• 조립 관계도 확인 “Show Part Locations”

• 시각화 기능 활용 검토(Sensitivities, Response)

12

3

4

세번째로 

1,2번 작업을 진행하면서 사용된 
각 부품 별 features의 위치 및
사이즈(공차)를 정의 합니다. 

https://www.tsne.co.kr/
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Stack-up Tolerance 따라하기(실습)

• Part Modeling 작업 준비

1
2

3

BASE

“BASE“ Part를 더블클릭 합니다.
→ “BASE“ Part만 활성화 됩니다.

이번 작업에서는 
“BASE“ Part에서 사용되어진 features 정보들만 관계구성을 합니다.
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Stack-up Tolerance 따라하기(실습)

• Feature 네이밍 지정 → Tree Feature 순서 변경

1. 각 Feature의 네이밍을 지정하고,
2. Drag & drop으로 feature의 순서를 정렬합니다.

바닥면

좌측면

우측면

각 Feature의 네이밍 방법

• CETOL Tree에서 feature 더블클릭 후 네이밍

or

• CETOL Model Graph에서 

feature 더블클릭 후 네이밍

BASE

Tree Feature 순서 

32

https://www.tsne.co.kr/
https://www.tsne.co.kr/pc/public/sub2/7-0-0.php


Stack-up Tolerance 따라하기(실습)

• 치수관계 설정

1. “바닥면” feature를 선택합니다

2. Dimension 탭에서 Dimension아이콘을 
클릭합니다.

3. “좌측면” feature를 선택 후 OK 클릭 합
니다. (tree 또는 graph에서 선택)

4. 팝업창에서 OK 버튼 클릭합니다.
(Add Dimension)

팝업창 에서 OK버튼을 클릭 합니다.
→ Cancel 누를 시에 설정은 취소 됩니다.

작업 후 완료된 모습
• CETOL Model Graph
• CETOL Tree

(1번 작업 미진행시 아이콘 활성화 안됨)

BASE

33
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Stack-up Tolerance 따라하기(실습)

• 치수관계 설정

BASE

1. “우측면” feature를 선택합니다

2. Dimension 탭에서 Dimension아이콘을 
클릭합니다.

3. “좌측면” feature를 선택 후 OK 클릭 합니
다. (tree 또는 graph에서 선택)

4. 팝업창(Add Dimension) 에서 공차정보 “±0.2” 
입력 후 OK 버튼 클릭합니다.

(1번 작업 미진행시 아이콘 활성화 안됨)

작업 후 완료된 모습
• CETOL Model Graph
• CETOL Tree

https://www.tsne.co.kr/
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Stack-up Tolerance 따라하기(실습)

• Part Modeling 작업 준비(Feature 네이밍 지정 → Tree Feature 순서 변경)

Block1

“1“ Part를 더블클릭 합니다.
→ “1“ Part만 활성화 됩니다.

바닥면

좌측면

우측면

1. 이전 슬라이드(BASE)에서 작업한 것과 
동일하게 진행 합니다.

2. “1” Part 활성화
3. 각 feature 네이밍 지정
4. Tree에서 각 Feature 순서 지정

1
2

3
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Stack-up Tolerance 따라하기(실습)

• 치수관계 설정

1. 이전 슬라이드(BASE)에서 작업한 것과 
동일하게 진행 합니다.

2. “1” Part 활성화
3. 각 feature 네이밍 지정
4. Tree에서 각 Feature 순서 지정

5. “바닥면” feature 선택 후 Dimension 
탭에서 Dimension아이콘을 클릭합니다.

6. “좌측면” feature 선택 후 OK버튼을 
클릭 합니다. 
(이후 팝업창에서 OK버튼 클릭) 

Block1
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Stack-up Tolerance 따라하기(실습)

• 치수관계 설정

Block1

1. “우측면” feature를 선택합니다

2. Dimension 탭에서 Dimension아이콘을 
클릭합니다.

3. “좌측면” feature를 선택 후 OK 클릭 합
니다. (tree 또는 graph에서 선택)

4. 팝업창(Add Dimension) 에서 공차정보 
“±0.3” 입력 후 OK 버튼 클릭합니다.
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Stack-up Tolerance 따라하기(실습)

• Part Modeling

• BASE 및 Block1에서 작업한 것과 동일하게 Block2, 3모델에서 진행 합니다.

Block2

Block3

Block3 에서는
치수 상세창(Properties)에서
비대칭 공차역을 설정 합니다.

→ Type에서 (Plus/Minus) 선택

1
2

3
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Stack-up Tolerance 따라하기(실습)

만약 Joint 에러가 발생 했다면

기 선택되어 있는
Line Contact Along X 항목에서
Line Contact Along Z 으로 변경하여
선택 합니다. 
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Tolerance Analysis Procedure

CETOL 6 Modeler
Assembly Modeling

• 기구학적 조립 관계 설정

• 조립 상세 설정

Define Objectives

• 분석 위치(검토지점) 설정

• 분석 취치 상세 설정

Part Modeling

• Feature관계 설정(Size, Dimension, GD&T, etc.)

• 공차 상세 설정

Validate Model

• (정보, 경고, 에러) Advisor message 확인

• 조립 관계도 확인 “Show Part Locations”

• 시각화 기능 활용 검토(Sensitivities, Response)

12

3

4

네번째는

구성한 모델을 검토하고,
결과확인과 도면 개선작업을
진행 합니다.
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Stack-up Tolerance 따라하기(실습)

• 결과보기

• 3 Analyze 탭에서 Solve버튼을 
클릭 합니다.

• 모델구성에 문제가 없다면 Status에 “Ready”라는 
문자가 표현 합니다.

• 문제가 없다면 팝업창에서 OK 버튼을 클립 합니다.

• 계산 시간은 1초 내외 입니다.
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Stack-up Tolerance 따라하기(실습)

측정지점
Min/Max값은?

1
2

3

Block 1 Block 2 Block 3 Block total

Max 30.3 20.2 25.1 75.6

Min 29.7 19.8 24.8 74.3

BASE

Max 80.2

Min 79.8

Max / Min

5.9

4.2

품질 요구사항이 Max: 5.5 / Min 4.0 이라면?

• Measure를 선택하고 3번탭에 있는 
“View Results”를 클릭 합니다.
(팝업창 발생)

품질 요구 범위를 입력합니다.
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Stack-up Tolerance 따라하기(실습)_ 결과 개선 검토

클릭

기여도 결과
리스트

불량 범위가 양품 영역에 포함 될 수 있도록 
기여도 리스트의 공차범위를 조정해 보세요

불량 영역양품 영역

여기서 기여도란?
→ 품질에 영향을 미치는 정도(비율)을 말함
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서울특별시 성동구 성수이로7길 27 10F 태성에스엔이

(27, Seongsui-ro 7-gil, Seongdong-gu, Seoul, Korea 133-120)

E-Mail : cetol@tsne.co.kr

Technical Support of 3D Tolerance Analysis
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